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1.0 Rehab Anywhere Overview

1.1 Purpose
ARTSCO’s Rehab Anywhere® is a portable documentation assistant system that reduces the time necessary to complete medical justification paperwork.

Rehab Anywhere’s “Documentation Assistant” software contains computerized versions of over 250 wheelchair specification sheets. The “Assistant” automatically matches the wheelchair a clinician recommendes with current HCPCS codes including the Medicare and Medicaid allowables, and organizes all the information gathered during an evaluation into price quotations, costing, and a medical justification report individualized to each client. 

In addition to making it simple to complete Medicare and Medicaid forms, Rehab Anywhere can be customized to your organization so that you can use computerized versions of the evaluation forms, purchase orders and other forms that you are presently using. 

1.2 Custom Form and Report Service 

ARTSCO, Inc. offers a custom form and report service. At your request, we can replicate any form you presently use in your organization for use in Rehab Anywhere. Computerizing your form or report reduces the time it takes to generate paperwork related to evaluations. Information typed into the Rehab Anywhere Documentation Assistant can be formatted to look identical to your present forms and reports. Call ARTSCO’s Form and Report Service department at 1-800-798-3858 for more details.
2.0 Rehab Anywhere Software Installation

If you are uninstalling and reinstalling a computer with Rehab Anywhere already loaded, please complete all steps. If you are installing on a new computer please start at Step 3. 

1. Stop the server by double clicking on the RA DB Setup folder on your desktop, or the tower with the green arrow on the bottom right of your computer screen. Go to the Services Pull down menu, and make sure each is has a red square to show it is stopped. If it is not press the stop button for SQL Server, MSDTC and SQL Agent.

2. Once the server is stopped uninstall the programs in this order: Rehab Anywhere Ver 5, Rehab Anywhere MSDE, Microsoft SQL Desktop engine.  Restart your computer.  After restarting, go to your windows explorer and go to the c:/program files section.  Delete any folders that are called Rehab Anywhere Ver 5, Microsoft SQL, or Rehab Anywhere MSDE.

3. Insert the Rehab Anywhere Ver. 5 installation disk into your computer’s cdrom drive.  A window should appear with installation instructions.  If after several moments it does not, manually open the cd through your windows explorer and double click on the installer.exe icon.

4. Click on Step 1 

5. Run through the setup program.  Parts of this setup will take some time; let it continue to the end.

6. After installation of Step 1 is complete, restart your computer.

7. In the bottom right hand corner of your screen (by the clock), a new icon should now be shown.  It looks like a grey tower with either a red square or a green arrow.  Double click on this symbol. Sometimes this icon is not visible.  If you do not see the icon, open the RA DB_Setup Folder that is located on your desktop.  Double click on the Service Manager to open up your Service Manager.  A box called SQL Server Service Manager will open up.  Next to where it says Services is a pull down box with three names.  Select each of these names, one at a time, and click the start button and check the check box for each service.  Note: Windows 98 will not allow you to check the box for SQL Server. This is OK and you should continue one.  All three services should now have a green arrow and the Services box should now read SQL Server.  Close this window by clicking on the red X in the upper right hand corner.  If you do not see the SQL icon at the bottom of the screen or if you have any questions about this section, call ARTSCO.

8. Eject the installation cd and put it back in to get the installer program to come up again.  Or double click on the installer.exe icon.

9. Click on Step 2.

10. Run through the installation program by clicking on the next boxes.  Your password is on the back of the cd case.  Check on the Ver. 4 transfer box if you previously had Ver. 4.  Choose a typical install.  At one point a black DOS box will appear.  This will take some time.  If it appears more than 10 minutes and your hard drive does not seem to be thinking, call ARTSCO.

11. After the setup is complete, repeat Step 5 to make sure that all of your services have green arrows.

12. At this point, connect your computer to the Internet if it is not already.  A COMPUTER MUST BE ABLE TO CONNECT TO THE INTERNET FOR VERSION 5 TO SYNCHCRONIZE.
13. Double click on the RA Ver 5 icon on your desktop.  For now, type in sa for your username and leave your password blank.  The local box should be selected.  In the bottom right hand corner of your login box.  Set the check boxes so the program will synch only when it closes.  Finally, click OK.

14. You are now in Version 5.  Click on the file menu in the upper left hand corner and select exit.  A synch box will come up and the program will now synch to the web (this box should not be blank, you should see many processes running through).  The synching will take up to 30 minutes to complete, do not interrupt this process.  If nothing seems to be happening in the box, i.e. it is blank or comes up with an error message such as a timeout, leave the box up and call ARTSCO.

15. Repeat the installation process on each computer.

3.0 Using the Windows Based Rehab Anywhere System

Rehab Anywhere uses three windows to present a clean, easy to use interface. The left side of the screen is a tree structure that you can use to select the client, form or administrative action on which you would like to work. The top right side of the screen presents the active form, whether it is a manufacturer spec sheet, standard Rehab Anywhere form, or custom form. The bottom right of the screen presents a grid. The grid is the area where you can add, delete or edit data in a table format. With this interface, whichever of the three screens you are active in will occupy 95% of the screen. When you click on a form name in the tree, it will automatically bring up the form in a large window occupying most of the screen. You can then click back into the small space on the left side of the screen to enlarge the tree to pull up another form. The same is true for the grid.

4.0 Working with the Documentation Assistant

4.1. Logging in to Rehab Anywhere

Starting Rehab Anywhere brings up a log in screen. Type in your user name and password in the spaces provided, and then check the circle for local or remote. Local means you are typing information directly into Rehab Anywhere on your computer. An example would be if you were using the computer at a client’s house while not connected to the Internet. Remote means you are typing information into a database other than your computer. An example would be if you were connected to the Internet, and want to enter information that would be immediately available to others in your organization, or you want to enter information directly into the server at your site. Your system administrator determines your user name and password. Unless your organization has several sites, each with their own database, you will not need to use the pull down menu for “Other Data Base”. If you do have multiple databases, your system administrator will set up access to these databases. See the chapter on Security for more on how to set up user names, passwords, and multiple databases. 

Rehab Anywhere can be set during the login to synchronize when opening the program, and to synchronize when closing the program. Synchronization replicates the data on your computer with the data on the server. Synchronization also updates your computer with the most recent order forms and program updates. You must be connected to the internet, or if you have your own SQL network to your server, in order for synchronization to work successfully. You will see a black box on your screen displaying various messages during the synch process. The synch should complete without any action required by you. If you must hit the enter key to complete the synch then there has been an error. Try the synch again, and if it still does not complete, you may need to check the ReinitDB box. See the next paragraph for details. ARTSCO recommends you leave the checkboxes checked in order to make sure you have the most recent order forms, and company data, but if you are in the field and do not want to take the time for the program to recognize that you are not connected to the internet, you can uncheck the boxes during login, and the program will not try to synch. You can then recheck the boxes when you are connected to the internet, or your SQL server. 

The Reinit box on the bottom right of the login should only be checked if there is a problem during synching. If you are sure your connection to the internet or your SQL server are correct, and after two attempts the system will not synch, you should check the Reinit box and the synch on Open box and hit OK. The synch will take longer than usual, possibly up to an hour, but subsequent synchs will finish correctly without having to check the Reinit box. 
4.2. Getting Started with a New Client 


4.2.1 Adding a New Client

To add a new client, click on the folder on the left side of the screen that shows the name of the Rehab Specialist responsible for this client. If there is no Rehab Specialist folder, you can enter information on the Rehab Specialists by double clicking on the Team Members folder. You will see pages labeled Physician, Therapist, Facility etc. Double click on the Rehab Specialist page. The Grid will open, and you can begin typing in the names of the Rehab Specialist. Once there is a Rehab Specialist folder,  right click on the specialist and select “ Add New Client” to bring up a grid in the lower right window. To add a new client, begin typing in the row below the last client name. The information you may enter includes the client’s ID #, first and last names, social security number, and any comments you would like to add. The ID # of the client is optional. It is not generated by Rehab Anywhere, but can be entered by the user to help track client information. After you add the client you can right click and choose “Go To Intake Form” or double click on the gray arrow to the left of the name to go to the clients Intake Form. Additional clients can be added at this time by tabbing to the next line, and continuing to enter client data. You can stretch the height of the rows by clicking on the bottom of a line in the gray section on the left of the grid and dragging down. 

Once you have entered your clients, you can double click on the Rehab Specialist folder to see a folder for each new client. Double click on a client folder, and you will see a folder for the date the visit was created. Underneath this folder you will see page items for Justifications, Pick List Items, Edit LMN and Import\Export Documents, and Intake Form. The first three become important after you have chosen equipment, and will be discussed later. Double click on the Intake Form page.You can change the size of the image by right clicking on the form, and choosing the magnification that suits you. Click into the first field you want to fill, and start typing. Tab to the next field to continue filling the form. If you would like to fill in today’s date for a date field, you can hit the F2 key to paste in today’s date. If the field happens to have a four digit year instead of a two digit year you can press the F4 key instead of the F2 key. Some fields, like the Physicians, have multiple answers to choose from. Use the pull down menu to select your choice. The Physicians, along with other team members, can be added by first clicking in the field of the team member name (team members are Physicians, Therapists, Rehab Specialists, Facilities, Referral Sources, Care Givers, and RTS Company). If the team member is not already listed click on the Grid Symbol in the Toolbar directly to the right of the button to go to a different page of a form. You will see a message that says “Please Click OK, click on the Grid, enter Team Member Information, double click on the left gray button to enter row information into the form”. Following this will enter the Team Member information into the form.  You can not directly type in to fields with Team Member information. 

Sometimes the lists of Team Members and clients can become very long. To go directly to the bottom of the list to enter an additional entry you can first go to the grid of interest, then click on the Down Arrow in the Toolbar directly to the right of the Grid symbol and to the left of where you would type in text to search on. This will take the curser to the end of the list so that you can begin adding additional information. If the list is very long you may need to click on the Down Arrow twice to get to the bottom of the list. 

The field titled Equip. New, Rental, Other is used to determine modifiers for equipment choices. Some fields, such as Sales Rep and Insurance Names, are fields that you can only choose from the values given. The Administrator can add more insurance names, and sales reps, under the Administrator Menu. See the chapter on Administrator Menu for more information. See the following section for information on filling in diagnosis codes for a client. Once you have completed the Intake Form, you can double click on the Forms Folder in the tree, and then double click on the next form you would like to fill out. 

4.2.2 Specifying the Diagnoses for a Client

The four diagnoses codes on the intake form can either be typed in directly, or filled in from the grid on the bottom of the screen. If you know the diagnosis code, you can type it in, hit the tab key, and the description will be automatically be put into the Diagnosis Description field. If you do not know the number, and if the grid is not showing when you click into a Diagnosis Code field, click on the bar at the bottom of the intake form, and pull it up. This will reveal a grid with the ICD9 codes and descriptions. You can search for a particular word in a diagnosis by clicking on the word Description  (in grey background) at the top of the grid. This will make the entire Diagnosis column turn black. Next type the word or words you want to search into the space to the left of the binocular symbol on the toolbar at the top of the page, and then press the binocular. The search function will find the first diagnosis description with this or these words. If this is not what you are looking for, you can continue to hit the binoculars until the description you want is highlighted. To choose this diagnosis double click on the gray to the right of the ICD9 code, or right click on the gray and choose Paste Into Form.  Before you do this, make sure the curser is in the Diagnosis Code field you would like to be filled in.   If this is a code that you use often, you can check the Often Used box to the right of the description, and then the next time you fill in diagnoses this ICD9 Code will be a the top of the list. 

4.3. Creating a New Visit for an Existing Client 

The next time your new client is seen, you will want to create a record of this new visit. To create this new record, double click on the Rehab Specialist folder for this client, then right click on the client’s folder. You will see a command to “Add Visits”, and three options underneath. If you choose “Copy None”, only the client’s name, ID# and SSN will be copied to the next visit. If you choose “Copy Eval Info” all fields on all forms, except those relating to equipment and tracking information, will be copied. If you choose “Copy Eval and Equip Info” all fields, except tracking, will be copied to the next visit. After selecting the Copy Mode, and Adding a New Visit, you will see the grid on the bottom left of the screen to add a new visit. You can add notes for this new visit, and then double click on the visit folder to begin working with this visit. 

4.4 Adding a New Equipment List for a Visit 

You may want to have more than one equipment list for each visit. An example would be if a client is getting both a manual and power chair at the same visit. You would want to print these onto different CMN’s or quote sheets, but would also want to keep the two orders under the same visit. To add a new equipment list for a visit, right click on the visit folder, and choose “Add Equipment Lists”. This will open up a grid that allows you to add another equipment list to the visit, with its own page for Items, Justifications, Forms etc. You can open up any manufacturer order form, and select items that will be placed on a separate quote. 

4.5 Viewing a Client List

To view a list of all the clients within the system, double click on the “Select Client” page at the top of the tree.  This will open a grid that includes: client names, visit dates, and other basic information.  Each column is searchable to help find needed information quickly.  For example, if you would like to find a particular client, click once beside the word “client” in the grid to highlight the entire column.  Now, go to the top of the page and enter in the client’s name in the fill box to the left of the binoculars.  Click on the binoculars and the program will search for that particular client.  Double clicking in the grey box to the left of the visit date will open the client’s folder within the tree and bring up their intake form.  If your search term is general enough to apply to more than one client (such as entering in a visit date), clicking on the binoculars a second time will bring up the next result.

4.6 Deleting or Hiding a Client Record

If you have a client who is no longer active, but you still want to maintain records on this client, you can hide the client from view in the main database. To do this, double click on the page icon at the top of the tree (on the left of the screen) that says Hide Clients. This brings up a grid on the bottom right of the screen with a list of all of the clients and a box to the right labeled “Show”. If this box is checked, the client will be shown in the database.  However if the box is unchecked, this client will not be shown in the database unless you go back to “Hide Clients” and click the “Show” button for client. 

If you want to completely delete a client from the Rehab Anywhere database, first right click on the Rehab Specialist folder that contains the client’s name. This will open the grid with all the client names. Highlight the name of the client you wish to delete and press the delete key on your keyboard. Please not that if you can not delete a client, you may not have been given permission to delete from your system administrator. 
4.7 Entering Data into Spec Sheets

Rehab Anywhere contains specification sheets on over 250 wheelchairs by vendors including Sunrise Medical, Invacare, Permobil as well as several other manufacturers. In addition, Rehab Anywhere also contains specs on many seating and positioning components and other varied wheelchair accessories. All of the Specification Sheets in Rehab Anywhere are directly from the manufacturers. ARTSCO updates the spec sheets in Rehab Anywhere as soon as they are received from the manufacturers. The list of equipment manufacturers is located in the folder named “Manufacturers” under each client folder. Double click on the Manufacturer Folder to open all of the folders. Click on any folder symbol to open the folder for that manufacturer. Inside the folders, equipment (when applicable) is subdivided into Manual wheelchairs, Power wheelchairs, and accessory items.  Manual wheelchairs are then subdivided into 6 categories, and Power wheelchairs are subdivided into 4 categories. Opening a folder, by double clicking the left side of the mouse on the folder symbol, will display all of the wheelchairs for which Rehab Anywhere contains electronic documentation. Each wheelchair is identified by a page symbol. Double clicking the mouse on the page symbol will open the specification sheet. Click the checkboxes and/or fill in form fields to completely specify a wheelchair and all accompanying accessories. Move between the pages of a spec sheet by either clicking on the View menu, and choosing Next Page, Previous Page, or Go To Page.  You can also click the Next Page, Previous Page, or Go To Page icons on the toolbar (to the left of the search text field on the toolbar).  Make sure the window grid is “active”, by clicking on it, if the page icons are not working. Rehab Anywhere will keep track of all your equipment choices, and print the Manufacturers Spec Sheet as well as numerous quotes and forms. 

4.7.1 Searching within Order Forms

You can search for descriptions and part numbers within order forms by first opening the order form as described above, then typing your search term into the box to the left of the binoculars, and clicking on the binoculars. The first box containing your search term will begin to blink on and off. If this is the item you want you can click on the box. If it is not, you can hit the binoculars again and the next instance of your search term will be found. 

4.8 Editing the Equipment Selection List 

After selecting equipment for a client, you have the option of editing the selection list by either directly editing a form (listed above under the Forms folder) or clicking on Pick List Items under the Equipment List folder. You can edit directly on a form by double clicking on the Forms folder, then double clicking on the form to edit, and typing your edits on the form. This gives you the ability to edit the fields on the form, but it does not give you the ability to edit fields that are not on this form. To access all fields related to the equipment list at one time, double click on the Pick List Items page. Double clicking on the Pick List Items bring up a grid in lower half of the right side of the screen.  The first three columns, Equip Type, Manufacturer, and Model are Read Only, and cannot be changed by the user. The Sort Last Check Box allows you to place a particular item last when printed on your forms. If you modify the Description, the Desc Mod Check Box automatically checks. This indicates that you want to save this modification when you print to forms. If for any reason you want to go back to the original description, you can uncheck the box, and the next time you refresh the grid (double click on Pick List Items), you will see the original description. Changes to the Retail price, Code, Part Number, user Defined Part Number, and Allowable work similarly. Please note that these checkboxes DO NOT indicate that you are changing the value globally. To change the value for all future clients you must have Administrative Privileges, and do this under Administrator Setup (See Chapter On Administrative Setup for more information). You can change the code for an item by either using the pull down menu for the Code column, or start typing the code and it will automatically recognize the code. Immediately to the left of the Description of each item there is a box in a column labeled “Hide Items”. If you check the box for the item, the item will not print on the WC Spec Sheet for Quotes Retail or Allowable. This is very useful if Measurements of other no cost items are showing on the Quote, and you do not want them to show on the Quote. 

The properties for the checkboxes on the order forms are read at the time the box is checked. It is like taking a snapshot of the order form and copying the information into the Pick List and WC Spec Sheet. Rehab Anywhere has a feature which essentially tells the system to take a new snapshot and update all the values in the Pick List. To accomplish this right click on the Equipment List for which you want to update the values. Left click on the choice “Update Equip List Values”. This will automatically update all values for the equipment including Cost, Allowables, Codes, Descriptions etc. If you have previously modified the item yourself, using this update feature will not overwrite your change.

4.9 Deleting Equipment Selections

To delete an item, start by opening up the Pick List.  Next, click on the gray box to the left of the item, and hit the delete key on your keyboard.  Your equipment choice is now deleted.

4.10 Editing the Justifications for a Client’s Equipment

Each item in the Rehab Anywhere database that has a cost greater than zero is associated with a HCPCS code. Many HCPCS codes come with justifications for why a client would need this particular item, and, as described in Section 5.2.3, you can edit the default justifications as well as add new justifications to codes. To view the justifications for a client’s equipment list double click on the Justifications page under the client’s equipment list. All the justifications that listed for codes that match the equipment list will appear, but only those appropriate for the client will have the “Include” box checked. As described in Section 5.2.3, justifications can be qualified by ICD9 codes so that if a client has a particular ICD9 code, the “Include” box will be checked, but if the client does not have this ICD9 the “Include” box will not be checked. Since the justifications tend to be longer than one line, you should pull the bottom of the gray box to the left of the “Include” Box down to allow more reading room. The Code, Justification and Description of the item are listed in the right three columns. These justifications and descriptions will be printed onto the client’s Letter of Medical Justification. If you do not want a particular justification to be included, you can uncheck the “Include” box. Similarly, if there is a justification that you would like to include, but the box is not checked, you can check the box to put the justification in the letter. 

4.11 User Defined Equipment

Rehab Anywhere provides the ability to save custom equipment specifications so that they can be accessed at a later time. There are three levels to adding custom equipment. You can add a new manufacturer to the database, and then add new equipment for this manufacturer. Secondly you can add new equipment to a manufacturer that already exists within Rehab Anywhere. Lastly you can add custom equipment to a wheelchair, or other piece of equipment, which already exists within Rehab Anywhere. These functions can either be performed while in the manufacturer list for a particular client, or while in the section named “Forms, Not Associated With a Client”. The idea behind this is that if you want to add a large amount of User Defined Equipment at one time, you would go to the “Forms, Not Associated With a Client” section rather than arbitrarily picking a particular client.  However, if you are working in a client and decide to add a piece of custom equipment, you can do so under the client folder and still have it available for use on all future clients. The following describes the actions using the “Forms, Not Associated With a Client” folder, but they are exactly the same for using a particular client folder. The three levels of adding custom equipment are described below. 

4.11.1. Adding Custom Equipment for A New Manufacturer

To add a new manufacturer to the Rehab Anywhere database, double click on the “Forms, Not Associated With a Client” folder.   Then, double click on the “Manufacturers” folder. Right click on the Wheelchairs and Accessories folder. You will see a pop up that says “Add Manufacturers and Discounts”. See Section 4.12.3 for more information on entering Manufacturer Discounts. Left click on Add Manufacturers and Discounts. You will see the list of manufacturers appear in the grid on the bottom right. Scroll down to the bottom where you will see the * in the gray, and type in the name of the new manufacturer. You can also add a discount structure for this new manufacturer (as described in the Administrator chapter). To add more than one new manufacturer, proceed to the next line in the grid. 

When you are done entering manufacturers, double click on the Wheelchairs and Accessories folder.  You will now see the new manufacturers, put into alphabetical order, within the tree. Right click on your new manufacturer, and you will see choices for “Adding Custom Equipment Pages”, “Edit Model Discounts”, and Edit Model Tier and Pay By”. The last two choices are described in Section 4.12.3. Left click on “Add Custom Equipment Pages”, and the grid will change to give you a place to type in your new custom equipment. Our suggestion is that on this level you group your custom equipment into sections. For example you could type in three levels in the Grid for “Custom Seats”, “Custom Backs”, and “Custom Headrests”. The equipment type should be chosen as “Power”, “Manual”, or “Other”. In this example you would choose “Other”, but if you are adding new power or manual chairs you would choose either “Power” or “Manual”. The choice you make determines where the equipment is printed on your forms. Power equipment is printed first, followed by Manual, and lastly Other. Order Number determines the Order the Pages will show in your new company’s folder. After adding these the three entries for “Custom Seats”, “Custom Backs”, and “Custom Headrests”, double click on the folder for your new company. 

After double clicking you will see the new pages for your equipment groups. Right click on one of the pages, and you will see a choice for “Add Custom Equipment”, “Edit Item Discounts”, and “Add Tier Pay By Schedule”. The last two entries are described in the Administrator, Manufacturer Discount section. Left click on “Add Custom Equipment”. You will see a “Code Filter” box appear. This determines how you are coding the custom equipment. You can code for different insurances, and this is described in the Administrator, Insurances section. If you want to code for HCPCS Medicare codes, choose Medicare as the insurance, and click All for State, and All for Modifier. When you click OK, the Grid will change to give you a place to describe the Custom Equipment for this Page. You can type in a Description, Retail Price, Order Number meaning the order the equipment appears under the Page, Code, Part Number, User Defined Part Number, and Quantity. The checkboxes in this section should always be checked since ARTSCO does not overwrite any information saved in your User Defined Equipment section. Continue to add as many items as you like under this page. When you are done left click on the next page, right click to see “Add Custom Equipment”, and Left click to add new items for the next page. 

To view how you will use these new items for a client, scroll up to an existing client, or create a new client. Double click on the Manufacturer folder, and scroll down to the new manufacturer, which will now be in alphabetical order. Double click on the manufacturer, then a Page. You will see the items appear in the Grid, with checkboxes to select the items. 

4.11.2. Adding Custom Equipment for an Existing Manufacturer

Adding new equipment for an existing manufacturer is similar to the above section, with the exception that you do not need to go through the steps of creating a new manufacturer. Adding Pages within a manufacturer is an excellent way to save your most commonly used parts. You can create a Parts List once, and have it available for each of your clients.  Begin by right clicking on the name of the manufacturer in the “Forms, Not Associated With a Client” folder, and choosing “Add Custom Equipment Pages”. Next follow the same steps as in the above section to add the Custom Equipment Pages, and the Items within each custom equipment page. 

4.11.3. Adding Custom Equipment for an Existing Wheelchair, or Other

Page

With Rehab Anywhere you can add custom equipment to any wheelchair in the database. For example, if your company orders custom equipment on a particular wheelchair, you can describe it once within that wheelchair, and then have it available for every future order. To add custom equipment for a wheelchair, or any Page, click on the name of the Wheelchair in the “Forms, Not Associated with a Client” folder. Right click on the Page symbol, and choose “Add Custom Equipment Pages” and select your insurance.  After a few seconds the Grid will open with a place to type in a Description, Retail Price, Order # (the order the items will show when you are selecting them), Code, Part Number, User Defined Part Number and Default Quantity. Add as many items as you like at a time.  

4.12 Editing the Equipment Database

Each piece of equipment in the Rehab Anywhere database can be edited by the user, and saved to your database. These edits include the description of an item, its code, retail price, part number, and user defined part number. As described in Section 4.8, you can edit individual client equipment using the forms or the Pick List.  However, in this section you will learn how to edit the Rehab Anywhere database so that each time an item is chosen it pulls the information that has been customized by you. In addition to changing the HCPCS code of an item, you can recode any item in the database for insurances that use codes other than HCPCS. For example, if your state Medicaid has codes other than HCPCS, and you want to spec out a chair for a client, you can recode the chair once to your state Medicaid. Each time you give a client your state Medicaid, as the Primary Insurance, the chair will be coded with the correct codes and allowables for your state Medicaid. Section 5.2.3 described you to recode a HCPCS code to an existing code in your Insurance. If there is a HCPCS code that matches your state Medicaid code, using the HCPCS cross reference, as described in Section 5.2.3, would be the preferred method since this would recode every item in the database. However, if there is no HCPCS match to the insurance you are using, you would use the instructions below to recode the Rehab Anywhere database to your insurance codes.

4.12.1 Editing Equipment Descriptions, Prices and HCPCS Codes


To edit equipment descriptions, double click on the “Forms, Not Associated with a Client” folder. Next double click on the Manufacturers folder. Then double click on the Manufacturer, and single click on the page you would like to edit. Right click on the Page Symbol, then left click on Edit Equipment. The Grid will open with a full list of the equipment. You can change the description, code, retail price, part number and user defined part number for every item. The check boxes that end with the work Mod determine whether you want to save these changes when your database is updated by ARTSCO. For example, you may want to change the code of an item, and keep this change. In that case you would leave the Code Mod box checked. However, if a retail price changes before Rehab Anywhere updates your database, you may want to change the retail price in your database, but leave the Retail Mod box unchecked so that when your database is updated by ARTSCO, it will enter the same new retail price you entered.  However, when the price changes a few months later, your database will be updated. If you check the Retail Mod box, the Retail Price will remain at your setting for as long as you use the program. 

4.12.2 Recoding the Equipment Database for other than HCPCS 

To recode the Rehab Anywhere database to an insurance that does not have a HCPCS cross reference, left click on the Page you want to recode, and right click on Edit Equipment as described in the previous section. When the Code Filter window appears, choose the Insurance you want to code for using the Pull Down menu, and choose the state and modifiers you want this recoding to be effective for. If you want it to be for all states and modifiers then leave the boxes that say “All” checked. The grid will come up with the descriptions as described in the previous section, but the codes will now be blank. Click in the code box for the item you want to recode, and either type in the new code or choose it from the pull down menu. After you have finished recoding this chair, the next time you have a client with the insurance you used to recode, and the chair you recoded, it will automatically pull up the correct codes and allowables. 

4.12.3 Setting Manufacturer and Model Discounts

To set Manufacturer Discounts, double click on the “Forms, Not Associated With a Client” folder.   Then, double click on the “Manufacturers” folder. Right click on the “Wheelchairs and Accessories” folder. You will see a pop up that says “Add Manufacturers and Discounts”.  Left click here and a manufacturer grid will appear.  It is here that you can enter in “Discounts,” “Tier,” and “Pay By” for an entire manufacturer.  From now on, anytime you spec out a wheelchair for a particular manufacturer, these discounts will take effect.  The discount structure is set up so that you can have a base discount, and an extended or incentive discount. The first three columns are for the base discount you receive for Manual Chairs, Power Chairs, and other equipment respectively, and the second three columns are for the incentive discounts you receive for Manual Chairs, Power Chairs, and other equipment respectively.

To set Model Discounts, double click on the “Forms, Not Associated With a Client” folder.

Next, double click on the “Manufacturers” and “Wheelchairs and Accessories” folders.  Right click on the manufacturer folder that your model is in.  Choose “Edit Model Discounts” or “Edit Model Tier and Pay By.”  A grid will appear similar to that for manufacturer discounts.  Now when you spec out this particular model for any client, the discounts will be applied.
4.13 Creating Equipment Templates

Rehab Anywhere has the ability to save equipment templates that you use on a regular basis for immediate recall. Say for example on a regular basis you provide an Invacare 9000 XT with a particular combination of arm type, back type, frame finish, etc. You can save these choices into a template that you can immediately recall for the next client. To create a template, first go under the Forms, Not Associated with a Client folder, or if you are already working on a client you can start from a client folder. To create a template for the 9000XT, double click on the Manufacturer folder, then double click on the Invacare folder, and lastly double click on the 9000XT page. Click on the all the boxes you most often use to define the template. After all the boxes have been checked click in the text box field next to the search binoculars at the top of the page, and type in a name to save this template under, for example type in 9000 XT. Next hit the arrow immediately to the right of where you typed in 9000XT. This will save the template for later use. 

The next time you want to give a client this particular configuration of the 9000 XT, you can go under that client’s equipment list, double click on the Manufacturers folder, double click on Invacare, then the 9000XT to bring the form up in the window. Click the pull down menu to the right of the binoculars, and choose 9000 XT from the list. Click once on the 9000 XT form to make the two Template choices active, then click on the page symbol with the yellow arrow pointing to the right. This will activate the boxes that were selected for the template. All the descriptions, retail prices, etc will be save automatically into your forms. 

You can delete a template that you no longer need by choosing the template from the pull down menu, then clicking on the red x next to the page symbol you used to pull in the template. 

4.14 Editing the Medical Justification Report
Reports differ from forms in that they can be edited and customized to meet the needs of each individual client. The Letter of Medical Necessity pulls together information entered on the Wheelchair Seating Evaluation, Equipment Spec Sheets, and edits to equipment justifications to create one document that can be sent to funding agencies. After you have entered all information relating to a client visit, and are ready to create the Letter, double click on the Report Folder (within the client’s Forms Folder), and then double click on Create Letter of Medical Necessity. This will open up your LMN in a word processing program.  You can now edit the Letter using the word processing software. When done editing, choose save in the file menu.  This will save your file to the Edit LMN and Import\Export Documents Page of Rehab Anywhere. Once the LMN is saved into Rehab Anywhere, to open the document again, start by double clicking on the Edit LMN and Import\Export Documents Page in the Equipment List Folder.  A grid will appear with a list of file names.  Double click on the file name that is your LMN.  This will again open it in a word processing program.  Repeat the process once you have finished making corrections.

4.14.1 Importing and Exporting Other Reports 

You may want to save other reports in Rehab Anywhere.  To do this, open up your report in a word processing program. Now, save the document in the

c:\ProgramFiles\Rehab_Any_Ver5\Export folder. Next click on the Document Page in the Equipment List folder. Then right click and choose Import. Lastly choose the name of the file you want to import from the list of files.

Once you import the file into Rehab Anywhere you can delete the file from the Export folder. To work with the report at a later time, double click on the Edit LMN and Import\Export Documents Page. This will bring up a grid with the documents stored for a client. Right click on the gray to the left of the document you want to work with and choose Export. The file will be saved in your c:\Program Files\Rehab_Any_Ver5\Export folder. When you are done editing, repeat the import process again to store the file in Rehab Anywhere.

4.15 Using the Tracking Forms

Rehab Anywhere can produce tracking reports that assist in organizing client information. For example, Rehab Anywhere can produce a report of all clients for which CMN’s have been sent out but not received, or equipment that has been requested, but not received, and a multitude of other possibilities. The tracking process begins by filling out a tracking form for each client.  A standard tracking form and several reports are included with Rehab Anywhere, however you can request your own tracking intake form and reports. 

To access the standard tracking form, open an equipment list for a client, then double click on the second page symbol named Tracking. You will be presented with a list of questions beginning with a checkbox for On Hold, and a space to type in a reason why the equipment is on hold. The following question is the salesman’s name, and then there are several questions such as Date the first CMN was Sent, Date the CMN was returned, the Prior Approval Sent Date and Returned Date etc. Fill in as many answers as is appropriate at this time. Click on the names of other clients and fill in tracking information for these clients. 

There are 13 tracking standard tracking forms in Rehab Anywhere. These include Equipment Delivered and not Billed, Equipment on Hold, Equipment Sales, as well as other forms that track CMN’s, LMJ’s, and Insurances. These 13 forms are located in the Tracking Forms folder underneath the last Rehab Specialist folder. To print preview a form double click on the name of the form. You can print the form from this window by clicking on the printer icon. You can also print directly by single clicking on the name of the form, and choosing Print from the File menu. 

4.16 Entering Lists of Team Members and RTS Company Information

You can enter information on the Physicians, Therapists, Facilities, Rehab Specialists, as well as any other person or place that you define. To begin entering information double click on the Team Members folder. You will see pages labeled Physician, Therapist, Facility etc. Double click on the Physician page. The Grid will open, and you can begin typing in new Physician Information, or changing existing Physician information. It may be possible to import existing data into the Rehab Anywhere grid. Call ARTSCO for details on importing data that exists in another program. 

You can enter information about Therapists, Facilities etc. by clicking on the page symbol and entering data. You have the ability to add different types of Team Members under the Administrator Menu. See the Administrator Section for more details. Once the Team Member type (such as Care Giver, etc.) has been entered you can enter the information the same way you entered data on Physicians, Facilities etc. 

4.16.1 Entering New Company Ship to And Bill To Information

Rehab Anywhere has the ability to store additional ship to, bill to and company addresses in addition to the Default addresses used by the system. The method for adding RTS Company, Ship To, and Bill To information is the same, so the manual will describe only the RTS Company Ship To information.

ARTSCO programs your company information when you purchase Rehab Anywhere. To change the programmed information you can double click on the RTS Company in the Team Members section. The default box will be checked for the company entered. You can change the information entered by ARTSCO if anything is not correct. If you need to add an additional company you can go to the next line and begin to type information. This feature is very useful if you want to drop ship to the customer’s address or to another address within your company. 

Additional Ship To locations must be entered in the manner described above. The Ship To destination is changed by opening the Intake Form for the client, going to the second page of the form, and using the pull down menu to change the Ship To destination. If you add a Ship To destination under Team Members while you have the Intake Form open, you must refresh the Intake Form to see the new Ship to destination. 

You can change the Default Ship To Information by right clicking on the line that you want to be the Default, and choosing Set as Default. The Default Check will change from the previous Default to the new Default.

4.17 Changing the View Size of Forms and Spec Sheets

Forms and Spec Sheets in Rehab Anywhere can be viewed in several sizes. You can set the size by right clicking on the form, and click on the desired magnification level.   

4.18 Printing Forms and Reports (Print command, File menu)

The Print command under the File Menu prints forms, reports and spec sheets within Rehab Anywhere. There are two levels of printing, individual forms and batch printing. Each level of printing is described below.

Individual Forms

You can print a single form, report or spec sheet, or individual pages by opening the form and choosing Print from the File menu. For example if you want to print the CMN Manual for a selected client, first double click on the client’s name in the tree, then double click on CMN Manual under the forms list. With the CMN Manual on the screen choose Print from the File menu. A print setup window will appear where you can choose the destination printer as well as the page numbers you would like to print.  You can also Print Preview individual forms by choosing Print Preview instead of Print under the File menu. Print Preview is not available in batch printing. 

Batch Printing 

Batch printing allows you to choose a list of forms to print, and then leave Rehab Anywhere to do its thing while you take care of other important matters. To activate Batch Printing go under the File Menu and choose Select for Batch Print, and then Client. This will open up a list of your clients in the Grid. If you are only printing a list of forms for one client you can double click on the gray to the left of the client’s name. This brings up a list of all the possible forms to print. Click on the check box for each form you want to print. The check box to the right of the form name reads “All Pages”. If this box is checked all pages of the form will print, but if it is not checked then only pages with information entered will print. This feature is useful if you have selected equipment from a company such as AEL that has a 40 page catalog. Since you only need to print the pages on which you have selected equipment you can uncheck the “All Pages” box. However if it is an Invacare chair where they require all pages, then you would leave the box checked. If you want to print forms for more than one client, you can select more clients by holding down the control key, and choosing multiple clients instead of double clicking on one client. Next go under the File Menu, Select for Batch Print and choose Forms. You can now select one set of forms for the first client,  then scroll down to select different forms to print for the remaining clients. To activate Batch Print after you have selected the clients and forms, go under the File Menu, and choose Batch Print. This will initiate the printing of your selected forms. 

4.19 Backing up Client Files
To ensure that your client information is never lost, a backup of client data should be done at the end of each day. If your location is set up with an SQL network, we suggest running a backup to your server each night. If you are using the web server feature your data is backed up every night. 

5.0 Administrative Functions

5.1 Setting System Properties

You can set many system properties the first time you receive Rehab Anywhere. To set system properties, double click on the Administrator Set Up folder, then double click on the System Properties page. The Grid will open with many check boxes, and fields to enter. Starting from the left Billing Multiplier is the default number that MSRP will be multiplied by when you have a column that prints the Retail Price. For example if you enter 1.2 as the Billing Multiplier, and the MSRP of a chair is $1000, the Retail Price of the chair will print as $1200. You can override the Billing Multiplier for each item under the Pick List Items for a client. 

The CMN’s can be customized by the next 5 checkboxes:

(Start CMN Equip on Second Page leaves Section C blank on the first page, and then begins listing the equipment on the second page

(Use Discount on CMN means use your cost on the CMN Bill Column rather than Retail

(Use Allow for Bill on CMN means always use the allowable in the Bill Column of the CMN

(Use Greater Allow or Retail CMN Bill means if the allowable is greater that the retail, then the allowable should be put into the CMN Bill column, but if the Retail is greater than the Allowable, then the Retail Price should be put in the Bill column

(Do Number LMN Equip means put numbers on the Letter of Medical Necessity for each piece of Equipment, and match these numbers to the corresponding justifications

(Default Visit Copy Flag means default to either copying name and SSN only when creating a new visit for a client, or copying all Evaluation Data such as the Wheelchair Evaluation form, or copying Evaluation Data and all Equipment information. 

(Code Default Insurance ID refers to the Insurance Codes you would like to use as a default when either creating new insurances, or changing equipment coding selections. For example if you always recode equipment to Medicaid, with the state as CA and the Modifier as New. Then when you edit equipment these settings will automatically be active. If you do not change these settings, the default will be Medicare for all states, and New and Rental Modifiers. 

(Tier and Pay by for Manual, Power, and Other allows you to put in your tiers and in how many days your company pays by when purchasing from Manufacturers. This is most useful if you belong to a purchasing group that uses Tiers, and does its discounts by the number of days in which balances are paid. 

( “Use Extended Discount” means that Rehab Anywhere will use the Extended, or secondary discount, when determining your cost on an item. If you have secondary discounts entered, and you uncheck this box, your cost on reports will be determined using only your base discount on equipment. 

The last five choices are used in the Purchase Order system, which is an optional add on for Rehab Anywhere.

 (PO Prefix Function and PO Suffix Function are formulas that determine what goes before and after your PO numbers. For example if you want the RTS initials before the PO number, and the date of the PO after the PO number, these functions would automatically create this for each PO. These functions are SQL statements. If you are not familiar with writing SQL statements you should call ARTSCO to have your PO Prefix and Suffixes changed. The PO system has the ability to group clients together on PO’s if you want to save on shipping costs, or to put each client on a separate PO. 

(Check the Multiple Clients on PO box if you want to group clients together on a PO

The Purchase Order Module also has the ability to create a purchase order for the manufacturer with the longest delivery date first. It will then order the remaining equipment so that all equipment for the client arrives on close to the same date. For example if one manufacturer delivers in 5 days, and another delivers in 15 days, the PO system will order from the manufacturer that takes 15 days to deliver first, then wait 10 days to order from the second manufacturer. If you want to use this feature click the Use Just in Time box on. If the box is unchecked the system will place the order without regard to the expected delivery time. If you do use the Just In Time feature you can enter a number for how sensitive you want the system to be when ordering. For example if two companies deliver within 4 days of each other, and you want the system to go ahead and place these orders at the same time, you should enter 4 in the field. However if the difference in delivery is 5 days, the PO module will send the PO’s on different dates. 

5.2. Editing Insurance Information

5.2.1 Changing the Active States in Your Database

Rehab Anywhere comes with each piece of equipment coded to its appropriate HCPCS code, and the Medicare and Medicaid allowables for each state are loaded. However you also have the ability to add new insurance contracts. To begin working with the Insurance Information double click on the folder under Administrative Setup. You will see Pages for States, Insurances, Insurances for a State, Codes, Single and Codes, Multiple. Clicking on the “States” page brings up all the states active in your system. You may delete states out of your system by clicking on the gray to the left of the state initials, and hitting the delete key. This will decrease the number of codes and insurances presented to you when you move on to the next steps. 

5.2.2 Changing (Adding To) the List of Insurances in Your Database

The next page, titled “Insurances”, lists the insurances active in your system. You can add a new insurance name by going to the bottom of the list and typing in the name of the insurance. For example if you want to enter Blue Cross/ Blue Shield as one of the insurers you work with, type their name at the bottom of the list. You can also delete insurers you no longer use by clicking on the gray next to their name and hitting the delete key. 

After you add the new insurers, double click on the next page titled “Insurance for a State” You will see the list of insurances for each state active in your system. To add the details for the Insurer you added in the previous step, scroll down to the bottom of the list, choose the state in which the insurer resides in the State column, and then choose your new insurer from the pull down menu under the Insurance column. In the Modifier column choose whether this Fee Schedule is for New or Rental equipment. Under Insurance Type choose whether the insurance type is a Percent of Medicare, Fee for Service, Cost Plus, Retail Minus, Retail Plus or Base Cost Plus. If the insurer is anything but Fee for Service, you can enter the percentage in the Percent column, and you will be done. For example if the insurer gives Retail Minus 10%, you would choose Retail Minus for the Insurance Type, and put 10 in the percent column. If an insurer reimburses at 90% of Medicare allowables, you would choose % of Medicare as the Insurance type, and 90 as the percentage. The Mod checkbox should be checked if you do not want ARTSCO to overwrite the information you are entering. This is not an issue for new insurance that you enter, however if you change a Medicare allowable, and you do not want ARTSCO to overwrite this allowable on the next update, you should check the Mod box. Otherwise your changes will be overwritten with the new updated allowable. Sometimes an insurer will reimburse the lesser of two amounts. For example there may be a Fee Schedule, but if Retail Minus 15% is less than the Fee Schedule amount, then they will use Retail Minus 15 % as the allowable. You can program this by adding a value in the Lesser Insur Type column and the Lesser Percent Column. Rehab Anywhere will use the lesser of the two values to determine the allowable. 

If the insurance uses a Fee for Service schedule, right click on the gray to the left of the Insurer. You will see a choice for Fee for Service. Left click on the Fee for Service choice. Alternatively you can double click on the gray to the left of the Insurer. The Grid will open with the Codes for this insurer. If you choose a Medicare State, you will see a list of E codes and K codes with their allowables. If you choose a new insurance that you create the grid will be blank. You can begin typing in the codes this insurance uses and the allowables. Even though the insurance type may be Fee For Service, some codes may still use a different type of reimbursement. For example K0108 items will use Retail Minus a certain percentage. For this reason you can enter an Insurance Type for each code. If the majority are Fee For Service, you can highlight Fee For Service in the first field, go to the Edit Menu and choose Copy.  With the Fee For Service selected, hold down the shift key and put the curser at the last line of the same column to select the entire column.  Finally, go up to the Edit Menu and choose Paste Fill Range. This will fill in the entire column with Fee For Service. If for example a code uses a Retail Minus reimbursement, you can enter the percent off Retail in the Percent column. 

You can use a short cut to create Fee Schedules by copying an existing Fee Schedule. Typically you would use your state Medicare Fee Schedule to copy into a new Fee Schedule. Then you would only need to change the allowables, you would not need to enter in all the codes. To do this first open the Administrator Setup folder and double click on the Insurances Page, and add the name of the insurance if it is not already in the list. Next open the Insurance for a State page, and put the insurance into the bottom of the Insurance for A State table using the pull down menus, and refresh the Grid by again double clicking of the Insurance for a State page. Then highlight the Insurance you want to copy from, go to the Edit Menu, and choose Copy Insurance. Then highlight the one you want it to go to, go under the Edit Menu, and choose Paste Insurance. Make sure you are using the Copy and Paste for Insurances, and not the regular copy and paste. You should see it confirm you choice and hit OK. The codes and allowables will now be the same as the first insurance, and you can edit the codes and allowables of the new insurance by double clicking on the name of the Insurance in the Insurance for a State table. 

5.2.3 Cross Referencing HCPCS Codes

Rehab Anywhere gives you the ability to cross reference codes from insurances that do not use HCPCS codes. One example is that many insurances use an E1399 code which cross references to the HCPCS K0108 code. California Medicaid is one example of an insurance that uses the E1399 code. To perform the cross reference scroll down to the state CA, the Insurance Medicaid, and the Modifier New. Double click on the gray to bring up all the codes of that insurance. Scroll down until you see E1399, then to the right until you see the column titled HCPCS Cross Reference. You can narrow some of the columns by clicking on the bar between the titles and moving them to the left. This allows you to see the Code and HCPCS columns at the same time. Click in the HCPCS column for the E1399 code, and either type in K0108, or choose it from the pull down menu. Once you perform this operation once, every time a client has CA Medicaid, an item coded as a K0108 in Rehab Anywhere will print as an E1399 on your quote sheet. The allowable associated with your cross referenced code (E1399 in this case) will automatically be looked up and printed on your forms. 

5.2.4 Setting the Allowable Note and Mod Check Box
The allowable note is used if a Fee for Service code does not have a set allowable. In Report, Justify and MP are terms used by different insurances to demote that the reimbursement for this fee must be negotiated. Rehab Anywhere will list their allowable as Retail less the number entered in the Percent column. MSRP means the Manufacturer Suggested Retail Price will be entered. Checking the Mod box means you want to keep the changes you have made to this code, regardless of any Rehab Anywhere updates. 

5.3 Modifying Insurance Codes

5.3.1 Modifying Single Codes

You have the ability to add and describe any reimbursement code from any insurance you may use. To see the codes presently listed in the system double click on the “Codes, Single” page. You will see a list of all the codes that are used by the insurances that are presently active in your system. To the right of the Code are columns for the quantity used by the allowable and a description of the code. You can add to the list of codes by scrolling all the way to the bottom of the list, and type in a new code, quantity and description. You can add as many new codes as you have need for, then you can cross reference the codes as described above, or you could attach them to equipment items as described in the “Editing Equipment” Section. 

5.3.2 Setting the Justifications for Reimbursement Codes
Each reimbursement code can have one or multiple justifications for why a client would need this type of equipment. These justifications are put into the Letter of Medical Necessity to assist in explaining to the funding agency why this client needs this type of equipment. Rehab Anywhere has many predefined justifications. As an example, scroll to the K0016 code (or find it by clicking on the gray column heading titled Code, and type in K0016 in the Search Field, and hit the binoculars). Double click on the gray to the left of the K0016 (or right click and choose “Code Justifications”). You will see a list of possible justifications for an item coded as a K0016. The Order Number determines the order the justifications show up under the client file (See the Section on Editing Client Justifications for more detail). Each justification can have the Qualify, Auto box checked, which means that justification will always be checked on in a client file, or it can have an ICD9 code entered in the Qualify, ICD9 column. This would be used if a justification applies only if a person has a certain condition. For example the first Justification might be used if a person has Cerebral Palsy, and the second Justification would be used if a person has paraplegia. You would enter the ICD9 code for Cerebral Palsy in the first Justification row, and the ICD9 for Paraplegia in the second Justification row. If you do not check the Qualify, Auto Box, and you do not enter an ICD9 code, the justification will still transfer to the client justification area, but it will not be checked, and would need to be manually checked on to be put into the letter on Medical Necessity. The column titled Qualify, SQL is for entering an SQL statement. Someone very knowledgeable in the writing of SQL statements should only attempt this. Otherwise it should be left blank. 

5.3.3. Entering Multiple Codes

Sometimes an item uses more than one reimbursement code. An example is a standard wheelchair with a reclining back. This item would use a K0001, and a K0028. The code combinations that are currently used in Rehab Anywhere can be seen by double clicking on Codes, Multiple. There you will see a list of approximately 25 code combinations. You can add additional code combinations by going to the bottom of the list, and double clicking in the last row. This will bring up a column that says Code, and a Pull Down Menu. You can choose the codes that you want to combine into a Multiple Code. When you have added all the codes, you can hit the arrow pointing to the left in the Toolbar to go back to the Multiple Code list.  You can add as many combinations as you need. These combinations will be available when you code equipment, either globally under the Edit Equipment section, or for a particular client under the client Pick List Items. 

5.4 Creating the ICD9 Choice List

You can customize your own list of commonly used diagnosis within Rehab Anywhere. To do this, double click on the ICD9 choice list under the Administrator Setup Folder. This will bring up three columns in the Grid: Code, Description, and Often Used. Rehab Anywhere has some ICD9 codes pre-picked. These are the codes we have found are commonly used in rehab. If you do not use these codes often you can uncheck the box, and they will no longer be at the top of the list. To find a code that you use on a regular basis, highlight the Description Column, and type in a Search term, then hit the binoculars. The first ICD9 code and description matching your search term will be highlighted. If you use this one on a regular basis, check the Often Used box. Hit the binoculars again to find the next description matching your search term. The codes and descriptions you check will be presented at the top of the list when you assign ICD9 codes and descriptions to clients under the Intake Form. 

5.5 Setting the Team Members Type

Rehab Anywhere has the ability to store a list of names for your Physicians, Therapists, Facilities, or anything else you can imagine. To see the types of Team Members, and to add more, double click on Team Member Types under the Administrator Menu. There you see the Team Member types already added such as the name of the RTS company, and the Billing and Shipping Addresses, Physicians, Rehab Specialists, etc. To add another Type to the list scroll to the bottom and add your particular name for a list of names or places that you work with. You will do the actual adding and editing of the list under the Team Members folder as described in Section 4.16. 

5.6 Setting the Security Features

5.6.1 Setting the Security Levels

Rehab Anywhere has the ability to allow access, or deny access to many features of the program, based on a user’s login name and password. Since it is likely that you will have several users with the same or different login privileges, a section within the tree was created and called “Security”, which allows you to define specific security levels. For example, if each of your people has access to different Rehab Specialists, Team Members and forms, then you will need different security settings for each person. However if all your Rehab Specialists can access the same clients, team members, and forms then you could have one Security Template called Rehab Specialist.  If you do not want to have any security at all in the system, you can have one Security Level, maybe called Everyone, and check the “Full Access” box. Each person you add to the system would then be given the Security Level “Everyone”. However if you want to set different Security Levels, you can check the boxes below  “Full Access”:

 (RTS: Name of RTS means they have access to this RTS’s clients

 (Hide Clients means they have the ability to go into the Hide Clients page and keep       

   clients from being shown

 (View Clients means they can see the clients in the tree 

 (Edit Clients means they can change the fields on the client forms, and change 

    information in the grid relating to a client. 

 (Add Clients means they can add clients to the Rehab Specialists they have access 

    to

 (Delete Clients means they can delete clients of the Rehab Specialists they have 

   access to 

 ( Add People and Can Delete People means that they can add and delete Physicians, 

   Therapists and other lists of people and places

 (Access Template means they can use the Template Feature, which saves equipment 

   configurations for use at a later time. 

 (Add Edit Custom Equipment and Can Delete Custom Equipment means they can  

   add and/or delete custom equipment into the manufacturer tree 

 (Add Edit Manufact and Can Delete Manufact means they can add and/or delete 

   new manufacturers from the list of manufacturers

 (View Discounts means that this level allows a user to see the company discount 

   structure

 (Access Discounts means that the people on this level can change the company’s 

   discount structure 

 (View PO and Can Access PO similarly means people on this level could view 

   and/or access the Purchase Orders created by the system

 (Access Tracking All means that the users can enter dates into the tracking forms for 

   all clients to which they have access

 (Access People Types means that they can go under the Team Members section, and 

   add new types of Team Members as described in Section 4.16. 

 ( Access Justify means they can access the Justifications page for a client, which 

   allows a person to change the justifications relating to the equipments chosen for a   

   client. 

 (Access Insurance means they have access to the Insurance Information folder 

   under Administrator Setup, and therefore can add and/or delete new insurances and 

   insurance codes.

 (Access ICD9 means they can go under the ICD9 Choice List page in the 

   Administrator Folder, and select the commonly used ICD9 codes. 

There is also a list of your Rehab Anywhere forms, and you can set each user to either view and/or edit, or not have access at all to each form. 

5.6.2 Setting Security Logins

Double clicking on the “Add Users” page, under the Security Folder, will bring up a grid that allows you to add users and create passwords for these users.  To add a user, click within the grid and enter in a user name and password.  Once all of your users have been added in, double click on the “Users” folder, within the tree, in the security section.  Contained within this folder there will be a page for each user you have added.  By double clicking on a user page, the security preferences grid will appear.  This allows you to set security preferences for each user by checking or unchecking boxes. You will probably want to create a template for each security level you would like to create.  This will save the time of checking many boxes each time you add a new user.

To create templates for Security Levels, double click on the Security Folder under the Administrator Menu, and then double click on the Add Templates Page. The Grid will open, and you can now create a security template to use with created users.  This Grid, for example, can be used to determine whether a user can see all clients, or just the clients of a set of Rehab Specialists.  After you have selected your desired security preferences, it is time to name and save your template.  Click within the text box, to the right of the binoculars, and name your template.  To the right of this text box are three buttons.   Click on the farthest left button (with a yellow arrow pointing left), your template is now saved.  You can create multiple templates for different users by following the previous steps.  To use a template, double click on the “Users” folder in the Security section of the tree.  Double click on the user you would like to set.  When the grid appears with the security settings, click once within this grid.  Now, go above and pull down the menu that contains your template names.  Choose a template name. To the right of the template name, choose the middle button (with the yellow arrow pointing right), which is called “Fill From Template”.  The grid should now fill with your desired security settings.  You can change individual settings by checking or unchecking boxes within the grid.  The red “X” to the right of the “Fill From Template” button allows you to delete undesired templates.

There may be a need, after you have set the login information for a Rehab Anywhere user, to change this information. Examples would be if decide that someone should be moved up to a higher security level, or a users password is no longer secret, and must be changed. Double clicking on “Add Users” page allows changes to passwords.  Double clicking on the user page within the “Users” folder allows you to change security levels. 

6.0 Purchase Order Module (Optional)

A Purchase Order Module, to track stock and orders, can be added to Rehab Anywhere for an additional charge.  Start by double clicking on the “Purchase Orders” folder in the 

tree.    Now you will see three pages (“Hide PO”, “Purchase Orders”, and “Hide to Stock POs”) and one folder (“Select Equipment for Stock”).  Start by double clicking on the “Purchase Orders” page; a grid will now appear showing all of the clients and their equipment manufacturers.  It is here that you can enter much of your purchase order information including: PO #, order date, and delay for same time delivery.  To enter and edit PO information for a particular piece of equipment, double click on the grey box to the left of the client ID.  This will change the grid to show an item-by-item list of equipment for the chosen client.  Here you can view and edit information about a specific piece of equipment including quantity ordered and units received.  To move back to the previous grid, click on the left pointing teal arrow on the above task bar.  Rehab Anywhere has two ways in which it will automatically generate PO numbers for you.  Click on the “Edit” menu at the top of the screen.  Now click on “Generate PO Numbers” selection.  You can either generate POs by “Checks” or “Selections”.  To generate by checks, the system will generate POs for those client/manufactures that have the “Ready To Order” box checked.  Place a check in the “Ready To Order” column of each item you would like generated.  Now go up to the “Edit” menu and the “Generate PO Numbers” option.  Select the “Checks” option.  Your POs will now be sorted below in the grid.  You can also generate PO numbers without choosing “Ready To Order” by selecting different items.  To do this, click once in the grey box to the left of the “Client ID” that you would like to generate.  By holding down the control key while clicking, you can select more than one item.  Now, go to the “Edit” menu.  Select “Generate PO Numbers” and “Selections”.  This will now generate POs numbers for all items selected.  

To help manage your POs, you can sort and hide them.  To sort POs, double click on the “Purchase Orders” page.  Click once within the grid and go to the “Edit” menu.  Now select “PO Sort Type”.  You have six choices to sort by (“Ready To Order”, “Ready For PO, Client”, “Ready For PO, Manufact”, “Receive PO”, “Receive Client”, and Receive Manufact”), select any of these and the grid will re-arrange itself accordingly.  To hide POs so they will not appear in the grid, click on the “Hide PO” page in the tree.  This will open a grid with all of the POs that have been numbered.  Check or uncheck the “Show” box to determine whether the PO will appear in the “Purchase Orders” grid. 

The Purchase Order Module also allows you to keep track of items ordered for stock.  Right Click on the “Select Equipment for Stock” folder in the Purchase Orders section.  Click on “Add PO For Stock”; a grid will appear with a list of all of the POs for stock.  Name your PO and double click on the “Select Equipment for Stock” folder.  Your named PO will now have it’s own folder.  Double click on the “Manufacturers” folder and select equipment as you would for a client (see section 4.7).  After you have chosen your equipment, double click on the “Pick List Items” page directly above the “Manufacturers” folder in the tree.  This will bring up a grid that will allow you to view and make changes, such as discounts, to your equipment.  You can hide your Stock POs just like your other POs by double clicking on the “Hide To Stock POs” and checking or unchecking the “Show” box.  

7.0 Rehab Anywhere Technical Specifications

Required Specifications for Computer Platform

IBM PC or compatible

Windows 2000 or above (NT needs Service Pack 5.0)

Pentium 1 GHz Processor

256MB RAM

500MB Hard Drive space

CD ROM Drive

Internet Connection

Internet Explorer 5.02 or above
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